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Product notice
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hardware, drivers, and/or software to take full
advantage of Windows 8 functionality. See
http://www.microsoft.com for details.
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separately purchased hardware and/or a DVD
drive to install the Windows 7 software and
take full advantage of Windows 7 functionality.
See http://windows.microsoft.com/en-us/
windows7/get-know-windows-7 for details.
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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily harm
or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage to
equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product features

Overview

The HP EliteOne 705 G1 23-inch Non-Touch AiO PC offers the following features:

● Integrated All-in-One form factor

● Full HD IPS, LCD display (1920 x 1080) with LED backlighting

◦ 58.4-cm (23-inch) diagonal

● Swivel pad under base of stand

● Stand can be configured to height-adjustable and reclining stand, basic stand, or no stand

● Removable panel on the back of the computer allows users or technicians to easily and efficiently
service the PC

● VESA mounting holes (100 mm x 100 mm)

● AMD processors

● Up to 1 TB Hard Drive, 160 GB Solid State Drive, 256 GB Self-encrypting Solid State Drive, 500 GB Self-
encrypting Drive, or 1 TB Solid State Hard Drive

● Optional Tray-load HP SuperMulti DVD+/-RW SATA Optical Disc Drive, DVD-ROM disc drive, or Slim BDXL
Blu-ray Writer
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● AMD chipset

● Two SODIMM slots with up to 16 GB of DDR3 SDRAM memory and dual channel memory support

● AMD Radeon 3D graphics

● DisplayPort video out (with audio) for second display support

● DP audio, DP to VGA/DVI/HDMI dongle support

● Integrated Gigabit Ethernet (Broadcom 5672 GB NIC or LAN)

● WLAN and Bluetooth Combo Card, 802.11 a/b/g/n Bluetooth® 4.0

● Optional integrated full HD webcam and dual microphone array

● Premium stereo speakers

● Optional 6-in-1 media card reader

● 4 USB 3.0 ports, including 1 fast-charging port

● 2 USB 2.0 ports

● Choice of wired or wireless keyboard and mouse

◦ Wired USB keyboard and mouse

◦ Wired PS/2 keyboard and mouse

◦ Wireless keyboard and mouse

● Windows® 7 Professional 32-bit or 64-bit or Windows® 8.1 Professional 64-bit operating system

● 93-percent energy-efficient power supply

● ENERGY STAR® qualified, EPEAT® Gold+ registered

NOTE: For the latest specifications or additional specifications on this product, go to http://www.hp.com/
go/ quickspecs/ and search for your specific display model to find the model-specific QuickSpecs.

2 Chapter 1   Product features ENWW

http://www.hp.com/go/ quickspecs/
http://www.hp.com/go/ quickspecs/


Front components

Component Component

1 Webcam (optional) with privacy shutter 7 Mute speaker

2 Dual microphone array (optional) 8 Reduce volume

3 Webcam activity LED (with optional webcam) 9 Increase volume

4 16:9 widescreen LED-backlit LCD display 10 Mute microphone

5 Power LED 11 Decrease brightness

6 High-performance stereo speakers 12 Increase brightness

Touch the icon area (7–12 above) to cause the icons to illuminate, then touch an icon to activate it.

To change the volume or brightness, touch and hold the appropriate icon or touch it and repeat until the
volume or brightness has reached the desired level.

To mute the speaker or microphone, just touch the appropriate icon. The icon remains illuminated until you
touch it again to reactivate the speaker or microphone.
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Side components

Component Component

1 Hard disc drive activity LED 6 Headset/line out jack

2 HP 6-in-1 media card reader (optional) 7 Tray-load optical disc drive

3 USB 3.0 port, fast-charging 8 Optical disc drive eject button

4 USB 3.0 port 9 Optical disc drive activity LED

5 Microphone/line in jack 10 Power button
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Rear components

Component Component

1 Access panel 8 (2) USB 2.0 ports

2 Access panel latches 9 RJ-45 Gigabit Ethernet port

3 Security lock slot 10 (2) USB 3.0 ports

4 Power connector 11 DisplayPort connector

5 Serial port 12 Stereo audio line out

6 PS/2 mouse connector 13 Access panel and rear port cover security screw

7 PS/2 keyboard connector   
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Positioning the computer
This computer may be shipped with no stand, with a height-adjustable stand, or a tilt/swivel stand. The
computer may be placed in the landscape position with the HP logo on the bottom bezel or it may be placed
in the portrait position with the HP logo on the right side, as you face the computer.

CAUTION: Positioning the computer with the HP logo on the top or on the left is not supported.
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Adjusting the height-adjustable/reclining stand (optional)
This stand allows you to:

● adjust the computer height 110 mm (4.3 inches)

● rotate the computer position from landscape to portrait

● recline the computer backward up to +60 degrees

● tilt the computer to 30 degrees from the desktop

● swivel the computer up to 360 degrees right or left

To rotate the computer:

1. Grasp the computer by the sides and lift it straight up (1) to its highest position.

2. Press the top of the computer backwards (2).

CAUTION: The computer must be raised and tilted to provide clearance for rotating it.

3. Grasp the top right and bottom left of the computer and carefully turn it counterclockwise (3) until it is
in the portrait position (4).

WARNING! If the height-adjustable/reclining stand is installed, before laying the computer down for
service, first grasp the sides of the display and raise the display to the highest position.

Do not lay the computer down with the sliding stand in the low position. The stand may suddenly release,
which could cause injury or damage to equipment.

ENWW Positioning the computer 7



Adjusting the tilt/swivel stand (optional)
This stand allows you to tilt the computer forward up to -5 degrees or backward up to +30 degrees to set it to
a comfortable eye level.

The tilt/swivel stand has a swivel pad on the underside that allows you to swivel the computer up to 360
degrees left or right for the best viewing angle.
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2 Activating and Customizing the Software

NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in Windows 7
If your computer was not shipped with a Windows® operating system, some portions of this documentation
do not apply. Additional information is available in online help after you activate the operating system.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating system
is successfully activated. Doing so may cause errors and prevent the operating system from installing
properly.

NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to permit
the required airflow.

Activating the Windows operating system
The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to complete the
activation.

We recommend that you register your computer with HP during operating system setup so you can receive
important software updates, facilitate support questions, and sign up for special offers.

CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE PROCESS IS
COMPLETE. Turning off the computer during the activation process may damage the software that runs the
computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive, the
activation process could take up to 60 minutes.

Downloading Windows 7 updates
Microsoft may release updates to the operating system. To help keep the computer running optimally, HP
recommends checking for the latest updates during the initial installation and periodically throughout the life
of the computer.

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on the
screen.

2. After an Internet connection has been established, click the Start > All Programs > Windows Update.

3. Run Windows Update monthly thereafter.
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Installing or upgrading device drivers
When installing optional hardware devices after the operating system installation is complete, you must also
install the drivers for each of the devices.

In Windows 7, if prompted for the i386 directory, replace the path specification with C:\i386, or use the
Browse button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and software (and
firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display
If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font sizes,
and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or the
documentation that came with your monitor.

Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in Windows 8
Additional information is available in online help after you activate the operating system.

NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to permit
the required airflow.

Activating the Windows Operating System
The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to complete the
activation.

We recommend that you register your computer with HP during operating system set up so you can receive
important software updates, facilitate support questions, and sign up for special offers. You can also register
your computer with HP using the Register with HP app on the Start screen.

CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE PROCESS IS
COMPLETE. Turning off the computer during the activation process may damage the software that runs the
computer or prevent its proper installation.

Downloading Windows 8 updates
Microsoft may release updates to the operating system. To help keep the computer running optimally, HP
recommends checking for the latest updates during the initial installation and periodically throughout the life
of the computer.

Run Windows Update as soon as possible after you set up your computer.
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1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Customizing the monitor display
You can customize display settings for Windows 8 separately for the Start screen and the Desktop.

To customize the Start screen:

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings.

3. Click Personalize to change the display settings.

To customize the Desktop:

1. Click the Desktop app on the Start screen.

2. Right-click on the desktop, and then click Personalize to change display settings.
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3 Illustrated parts catalog

System parts
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Item Description

(1) Front bezel

(2) Power supply, 200W

(3) Left side panel 

(4) Right side panel

(5) Standard stand assembly

(6) Upper rear access panel

(7) Rear I/O cover

(8) Height adjustment stand

(9) Lower rear access panel

(10) Top rear trim

 Display panel (non-touchscreen; not illustrated)

 Non-webcam kit, for use in models without a webcam (not illustrated)

Keyboards and mice
Description Spare part number

Keyboard  

USB 724720-xx1

Washable 700510-xx1

Smartcard 701671-xx1

Mouse (not illustrated)  

PS2, optical 674315-001

Washable 724795-001

Wireless 674317-001

USB, optical 674316-001

USB, laser 674318-001

14 Chapter 3   Illustrated parts catalog ENWW



Misc parts

Item Description

(1) Heat sink (thermal module) (includes replacement thermal material)

(2) Card reader

(3) Fan

(4) Speakers (left and right)

(5) Mylar cover (power button board)

(6) Optical drive latch

 Antenna kit (not illustrated)

 USB to serial adapter (not illustrated)

 HP ultraslim keyed cable lock (not illustrated)
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Mass storage devices
Description

Optical drive (does not include bezel)

Blu-ray writer (BD-RE) drive

DVD±RW drive

DVD-ROM drive

Hard drive (not illustrated)

1 TB, hybrid SSD drive

500 GB, hybrid SSD drive

500 GB, 7200 rpm hard drive, self-encrypting (SED)

500 GB, 7200 rpm hard drive

500 GB, 5400 rpm hard drive, FIPS

320 GB, 7200 rpm hard drive

256-GB solid-state drive, self-encrypting (SED)

256-GB solid-state drive

180-GB solid-state drive

128-GB solid-state drive, self-encrypting (SED)

128-GB solid-state drive, 2280SS

128-GB solid-state drive

120-GB solid-state drive

32-GB mSATA drive
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Boards

Item Description

(1) Webcam module 

(2) Converter board

(3) WLAN modules

 HP WLAN 802.11 a/b/g/n, 2x2

 HP WLAN 802.11 a/b/g/n + Bluetooth 4.0

(4) Power button board

(5) Near field communication (NFC) controller

(6) System board
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Item Description

 For use in non-Windows 8 models

 For use in models with Windows 8 Standard

 For use in models with Windows 8 Professional

 Memory modules (SODIMM; PC3-12800, 1666-MHz; not illustrated)

 8-GB

 4-GB

 Processors (include replacement thermal material; not illustrated)

 AMD A10-7800B (3.7-GHz)

 AMD A8-7600B (3.1-GHz)

 AMD A6-7400B (3.5-GHz)

 AMD A4-7350B (3.4-GHz)

Cables
Description

Power button board cable

Backlight cable

Optical drive cable (data and power assembly)

Hard drive cable (data and power assembly)

Converter board cable

LVDS (display) reverse cable

Webcam cable

Adapter, DisplayPort to VGA

Adapter, DisplayPort to DVI

Adapter, DisplayPort to HDMI

DisplayPort cable
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4 Routine care, SATA drive guidelines, and
disassembly preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system
board. You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly
throughout a normal cycle. The device may function normally for a while, but it has been degraded in the
internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.
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Generating static
The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs from vinyl tray

Removing DIPs from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric
components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal grounding methods and equipment
Use the following equipment to prevent static electricity damage to equipment:
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● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground cords.
To provide proper ground, a strap must be worn snug against bare skin. The ground cord must be
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with
a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the work area
To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the
work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. Handle
them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance
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● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented sides
of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must be
provided on the enclosure, and the same operating guidelines listed above will still apply.

● Keep liquids away from the computer and keyboard.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care

General cleaning safety precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use
the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

22 Chapter 4   Routine care, SATA drive guidelines, and disassembly preparation ENWW



5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case
Follow all safety precautions in General cleaning safety precautions on page 22 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with a cloth
or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will evaporate
quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and
limit the airflow.

Cleaning the keyboard
Follow all safety precautions in General cleaning safety precautions on page 22 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 23.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 22
before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the
keys.

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too
much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is
available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed out. Be
careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.
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Cleaning the monitor
● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for

cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into the
housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 23.

Cleaning the mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 23.

Service considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power supply fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is off when
the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent system
board or component damage.

Tools and software Requirements
To service the computer, you need the following:

● Torx T-15 screwdriver

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● Tamper-resistant T-15 wrench

Screws
The screws used in the computer are not interchangeable. They may have standard or metric threads and
may be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the
unit. HP strongly recommends that all screws removed during disassembly be kept with the part that was
removed, then returned to their proper locations.
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CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard drives
only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the work
area to prevent damage.

Cables and connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting the
cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by parts
being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during the
reassembly process. Improper cable placement can damage the computer.

Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies
to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging
and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective
packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive while
the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer to
Electrostatic discharge information on page 19

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

Lithium coin cell battery
The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime
of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide for
instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery
is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire,
or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the battery.
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NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public collection
system or return them to HP, their authorized partners, or their agents.

SATA hard drive cables

SATA data cable
Always use an HP approved SATA 6.0 Gb/s cable as it is fully backwards compatible with the SATA 1.5 Gb/s
drives.

Current HP desktop products ship with SATA 6.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never bend it
tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

Cable management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these are not
designed to take excessive pressure on them.

● Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when the
parts are moved.

● When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the wires.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables down
into the chassis. Always position the cables to lay properly by themselves.
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5 Removal and Replacement Procedures

The following sections provide information about disassembling various components of the computer.

Preparing to disassemble the computer
To avoid injury and equipment damage, always complete the following steps in order, when opening the HP
Pro All-in-One.

1. Remove all media from the computer.

2. Shut down the computer.

3. After the system has completely shut down, disconnect the power adapter from the back of the
computer.

4. If a cable lock is installed on the rear of the unit, remove the lock.

5. Disconnect all other attached cables from the back of the computer.

6. If the height adjustable/recline stand is installed, before laying the computer down for service, position
the computer vertically by grasping the sides of the display, and then raise the display to the highest
position.

Place the computer face down on a soft flat surface. HP recommends that you set down a blanket,
towel, or other soft cloth to protect the screen surface from scratches or other damage.

WARNING! Beware of sharp edges inside the chassis.
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Removing the rear I/O cover
▲ Push the two tabs down, then rotate and lift the cover off the computer.
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Stand
Description

Tilt/swivel stand

Height adjustment stand

Two stands are available for the computer:

● Height-adjustable/recline stand

● Tilt/swivel stand

Height-adjustable/recline stand (optional)
To remove the stand:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Place the computer face down on a soft flat surface. HP recommends that you set down a blanket,
towel, or other soft cloth to protect the bezel and screen surface from scratches or other damage.

WARNING! Before laying the computer down for service, first grasp the sides of the display and raise
the display to the highest position.

Do not lay the computer down with the sliding stand in the low position. The stand may suddenly
release, which could cause injury or damage to equipment.
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3. Push the base of the stand down (1), and loosen the captive screws securing the stand to the unit (2).

4. Lift the stand up and off the computer.
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Tilt/swivel stand (optional)
To remove the stand:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Push the release button (1) on the bottom of the stand and pull the back of the stand off (2) the
computer.

3. Push the base of the stand down (1), and loosen the captive screws securing the stand to the unit (2).
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4. Lift the stand up and off the computer.

Installing an access panel security screw
You may prevent access to internal components and ports by securing the access panel and rear port cover.
Screw a T15 tamper-resistant Torx screw through the rear port cover and the access panel to prevent
removal of either.
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Access panel
The access panel is located on the rear of the computer.

The computer has one main rear access panel that allows access to internal components.

To remove the access panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Slide the access panel latches toward the edges of the unit, then slide the access panel toward the top
of the computer until it slides off the unit.

To replace the access panel, reverse the removal procedures.
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Drives
Replacing a hard disc drive

Description

Optical drives

DVD±RW drive

DVD-ROM drive

Blu-ray BD-RW SuperMulti XL Drive

Hard drives

1 TB hard drive, hybrid SSD

500 GB, 7200 rpm hard drive, self-encrypting (SED)

500 GB, 7200 rpm hard drive

500 GB hard drive, hybrid SSD

500 GB, 5400 rpm hard drive, FIPS

320 GB, 7200 rpm hard drive

256 GB Solid State Drive (SSD), self-encrypting (SED)

256-GB solid-state drive

180 GB Solid State Drive (SSD)

128 GB Solid State Drive (SSD)

128-GB solid-state drive, self-encrypting (SED)

128-GB solid-state drive, 2280SS

120 GB Solid State Drive (SSD)

32-GB mSATA drive

The hard disc drive is located behind the access panel on the lower left side of the computer (when viewed
from behind). The drive is housed in a removable cage.
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One or two 2.5-inch solid state drives (SSDs) or self-encrypting drives (SEDs) may be installed in the
computer. If a single drive is installed, it must be installed in the primary (lower) position.

● Removing a 2.5-inch hard disc drive

● Installing a 2.5-inch hard disc drive

Removing a 2.5-inch hard disc drive

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Pull the latch next to the lower side of the 2.5-inch hard disc drive cage away from the cage to release
it, then slide the cage toward the edge of the chassis and lift it out.
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4. If there is a second disc drive in the 2.5-inch cage, disconnect both cables from it.

5. Remove the four mounting screws from each 2.5-inch hard disc drive to be removed. Be sure to keep
the screws together with the blue rubber grommets to use to install a replacement drive.

NOTE: The primary drive is the lower position in the drive cage. If only one drive is to be installed, it
must occupy this position.

6. Remove the 2.5-inch hard disc drive(s) from the cage.

For instructions on installing a hard disc drive, see Installing a 2.5-inch hard disc drive on page 36.

Installing a 2.5-inch hard disc drive

1. Insert the 2.5-inch hard disc drive into the drive cage.

● To install a primary hard disc drive, insert the drive into the lower position in the drive cage. Be
sure to insert the end with the connectors first.

NOTE: The primary drive is the lower position in the drive cage. If only one drive is to be installed,
it must occupy this position.

● To install a secondary hard disc drive, set the drive into the upper tray of the drive cage. Be sure
the connectors are facing the same direction as the connectors of the primary hard disc drive.
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2. Fasten the lower 2.5-inch hard disc drive securely into the drive cage with four mounting screws with
grommets.

3. Fasten an upper 2.5-inch hard disc drive securely in place with the four standard screws that shipped
with the drive.

4. Position the 2.5-inch drive cage above its final site with the hard disc drive connectors facing toward the
center of the chassis. If the drive cage contains a secondary (upper) drive, locate the power and data
cables next to the drive cage and connect them to the secondary drive.
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5. Place the 2.5-inch hard disc drive cage into the chassis and slide it toward the center until it snaps into
place.
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Replacing the optical drive
The optical disc drive is located above the hard disc drive on the left side of the computer (when viewed from
behind).

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Push and hold the tab (1) at the back of the optical disc drive enclosure while sliding the drive (2) out of
the chassis.
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4. Pull the latch off the optical disc drive.

5. Remove the cover from the adhesive strip on the new latch. Align the two pins on the latch with the
holes in the new optical disc drive and press the latch onto the drive firmly.

NOTE: You may reuse the latch removed from the old optical disc drive.
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6. Align the new optical disc drive with the opening in the side of the computer. Push the drive in firmly
until it snaps into place.

NOTE: The optical disc drive can be installed in only one way.
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mSATA Solid-State Drive
The mSATA SSD is located on the system board to the left of the heat sink/processor. The drive is secured
with one Phillips screw.

NOTE: In the following image, the mSATA SSD is not shown.

To remove the mSATA SSD:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Remove the Phillips screw (1) that secures the SSD to the computer.
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4. Lift the SSD to a 45-degree angle, and then pull it away to remove it from the socket (2).

To install the mSATA SSD, reverse the removal procedures.
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Memory
Description

8-GB

4-GB

2-GB

The memory modules are located near the middle of the system board.

For proper system operation, the SODIMMs must be:

● industry-standard 204-pin

● unbuffered non-ECC PC3-10600 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:

● 1-Gbit, 2-Gbit, and 4-Gbit non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 SDRAMs; SODIMMs constructed with x4 SDRAMs are not
supported
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NOTE: The system will not operate properly if you install unsupported SODIMM memory.

HP offers upgrade memory for this computer and advises that the consumer purchase it to avoid
compatibility issues with unsupported third-party memory.

The system will automatically operate in single channel mode, dual channel mode, or flex mode, depending
on how the SODIMMs are installed. Refer to the following table to identify the SODIMM channel locations.

Location System Board Label Channel

Lower Socket SODIMM1 Channel A

Upper Socket SODIMM3 Channel B

● The system will operate in single channel mode if the SODIMM sockets are populated in one channel
only.

● The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not equal to
the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated with the least
amount of memory describes the total amount of memory assigned to dual channel and the remainder
is assigned to single channel. If one channel will have more memory than the other, the larger amount
should be assigned to channel A.

● The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

● In any mode, the maximum operational speed is determined by the slowest SODIMM in the system.

There are two memory sockets on the system board located behind the memory access panel. To remove or
install memory modules:

To remove a memory module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Place the computer face down on a soft flat surface. HP recommends that you set down a blanket,
towel, or other soft cloth to protect the screen surface from scratches or other damage.

3. Remove the access panel (see Access panel on page 33).
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4. To remove a memory module, press outward on the two latches on each side of the SODIMM (1), then
pull the SODIMM out of the socket (2).

5. To install a memory module, slide the SODIMM into the socket at approximately a 30° angle (1), then
press the SODIMM down (2) so that the latches lock it in place.

NOTE: A memory module can be installed in only one way. Match the notch on the module with the tab
on the memory socket.

The computer automatically recognizes the additional memory when you turn on the computer.
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Battery
The RTC battery is located to the lower right of the fan.

The battery is located in the memory compartment. The battery that comes with the computer provides
power to the real-time clock. When replacing the battery, use a battery equivalent to the battery originally
installed in the computer. The computer comes with a 3-volt lithium coin cell battery.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60° C (140º F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When the
battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. To release the battery from its holder, squeeze the metal clamp that extends above one edge of the
battery. When the battery pops up, lift it out (1).
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4. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the
positive side up. Push the other edge down until the clamp snaps over the other edge of the battery (2).
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WLAN module
Description

HP WLAN 802.11 a/g/n, 2x2

HP WLAN 802.11 a/b/g/n, 2x2

The WLAN module is located on the left side of the system board. The module is secured with one Phillips
screw and has two connected antennas.

NOTE: The procedure to replace the WLAN module must be performed by an HP technician.

NOTE: WLAN module appearance may vary.

To remove the WLAN module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Disconnect the antenna cables from the module (1).

4. Remove the Phillips screw (2) that secures the module to the computer.
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5. Lift the module to a 45-degree angle, and then pull it away to remove it from the socket (3).

To install the WLAN module, reverse the removal procedures.

When connecting the antennas cables, connect the cable labeled “1” to the MAIN connector on the module
and the cable labeled “2” to the AUX connector on the module.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.
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Heat sink
The processor heat sink is secured with five Torx screws – four captured, one shared, not captured.

To remove the heat sink:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. In the order indicated on the heat sink, loosen the four silver captive Torx screws (1) – (4).

CAUTION: Remove heat sink retaining screws in diagonally opposite pairs (as in an X) to even the
downward forces on the processor. This is especially important as the pins on the socket are very fragile
and any damage to them may require replacing the system board.

4. If still installed, remove the Torx screw on the left part of the heat sink (5).
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5. Lift the heat sink out of the computer (6).

CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal grease
on the surface of the processor or the heat sink.

To replace the heat sink, reverse the removal procedures.
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Processor
Description

AMD A10-7800B (3.7-GHz)

AMD A8-7600B (3.1-GHz)

AMD A6-7400B (3.5-GHz)

AMD A4-7350B (3.4-GHz)

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Remove the processor heat sink (see Heat sink on page 51).

4. Rotate the locking lever to its full open position (1), and then carefully lift the processor from the
socket (2).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the
system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to ensure
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be found on the
Web at: http://www.hp.com.
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Top rear trim
The top rear trim is located along the top of the back of the computer.

To remove the top rear trim:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Rotate the bottom of the trim up and off the computer. When installed, the trim snaps in to place.

To install the top rear trim, reverse the removal procedures.
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Webcam module
On products that ship with a webcam module, the module is located at the top of the computer beneath the
top rear trim. It is housed in a metal bracket that is secured with two Phillips screws. the webcam module has
one connector.

The webcam module is optional.

To remove the webcam module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Remove the top rear trim (see Top rear trim on page 54).

4. Remove the two Torx screws that secure the webcam module bracket to the computer.
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5. Rotate the assembly to gain access to the connector on the module, and then disconnect the cable from
the module.

6. To remove the module from the bracket, remove the two Phillips screws that secure the module, and
then separate the module from the bracket.

To install a webcam module, reverse the removal procedures.
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Antenna
The antenna route from the WLAN card to transceivers at the top of the computer (transceivers shown in
following image).

To remove the antenna:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Remove the heat sink (see Heat sink on page 51).

4. Remove the top rear trim (see Top rear trim on page 54).

5. Remove the Torx screws that secures each antenna transceiver to the frame, and then lift the
transceivers off the frame.
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6. Note the routing path for each antenna for replacement.

To install the antenna, reverse the removal procedures.

NOTE: When connecting the antennas cables, connect the cable labeled “1” to the MAIN connector on the
module and the cable labeled “2” to the AUX connector on the module.
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Lower rear panel
The lower rear panel is located under the stand and on the bottom rear of the computer. It is secured with
one screw.

To remove the lower rear panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Remove the stand (see Stand on page 29).
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4. Remove the screw (1) in the middle of the lower rear panel, and slide the panel downward to detach it
from the chassis (2).

To replace the lower rear panel, reverse the removal procedures.
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Fan assembly
The fan assembly is located near the middle of the computer and is secured with three Torx screws.

To remove the fan assembly:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the lower rear panel (see Lower rear panel on page 59).

5. Disconnect the two fan cables from the system board.

6. Remove the three Torx screws that secure the fan assembly to the computer (1).
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7. Remove the fan assembly from the computer (2).

To install the fan assembly, reverse the removal procedures.
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Speakers
The speakers are located at the bottom of the computer. Two separate speakers are each secured by two
Torx screws. To remove the left speaker you have to lift or remove the Mylar cover.

To remove the speakers:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the access panel (see Access panel on page 33).

3. Remove the stand (see Stand on page 29).

4. Remove the lower panel (see Lower rear panel on page 59).
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5. Remove the Mylar piece that covers the left speaker screw.

6. Remove two Torx screws that secure the left speaker to the computer.
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7. Remove two Torx screws (1) that secure the right speaker to the computer, and then disconnect the
speaker cable from the system board connector (2).

8. Remove the speakers from the computer.

To install the speakers, reverse the removal procedures.
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Converter board
The converter board is located on the left side of the computer (viewed from behind) under the main rear
cover. It is secured with two Torx screws and has two connectors.

Use the same converter spare part for all display panels; however, you must change jumper settings on the
board based on the display panel.

To remove the converter board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the lower access panel (see Lower rear panel on page 59).

5. Disconnect the two cables from the board (1).

NOTE: Be careful not to damage the cables when disconnecting them from the board. Do not pull on
the wires.

66 Chapter 5   Removal and Replacement Procedures ENWW



6. Remove the two black Torx screws (2) that secure the board to the computer.

Be sure to correctly position the jumpers on the converter board for the installed display panel. Refer to
the label in the chassis for jumper settings.

7. Lift the converter board from the computer.

To install the converter board, reverse the removal procedures.

Be sure to correctly position the jumpers on the converter board for the installed display panel. The jumper
settings are shown on a label near the converter board.
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Power button board
Description

Power button board

Mylar cover (power button board)

The power button board is located on the bottom left corner of the computer under the lower rear panel. It is
under a Mylar cover and has two connectors and one screw.

To remove the power button board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the optical drive (see Replacing the optical drive on page 39).

5. Remove the lower rear panel (see Lower rear panel on page 59).
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6. Remove the Torx screw (1) that secures the Mylar that covers the power button board, and then lift the
Mylar from the computer (2).

7. Disconnect the two cables (1) from the board, and then remove the Torx screw that secures the board
to the computer (2).

8. Remove the power button board from the computer.

To install the power button board, reverse the removal procedures.
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NFC sensor board
The NFC sensor board is located just above the right speaker (when viewed from behind). The NFC sensor
board is housed inside of a plastic holder and has two small cables connected to it. The location of the board
and an image of the board housed in its holder is shown in the following images.

To remove the NFC sensor board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the lower rear panel (see Lower rear panel on page 59).

5. Disconnect the large right connector (1) and smaller left connector (2).

NOTE: The cables and connectors on this board are small and fragile. Use care when disconnecting/
connecting the cables to avoid breaking the connectors on the board.

6. Press to disengage the tab (3) that secures the plastic housing that secures the board to the computer.
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7. Remove the assembly from the computer (4).

To install the NFC sensor board, reverse the removal procedures.
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VESA mounting plate
The VESA mounting plate is located under the stand and under the lower rear panel.

To remove the VESA mounting plate:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the lower rear panel (see Lower rear panel on page 59).

5. Remove the four Torx screws (1) securing the plate to the chassis.
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6. Lift the plate left straight up and off the computer (2).

To replace the VESA mounting plate, reverse the removal procedures.
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Power supply
The power supply is located in the middle of the computer under the VESA mounting plate. It is secured with
two Torx screws and has one connector routed to the system board.

To remove the power supply:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the lower rear panel (see Lower rear panel on page 59).

5. Disconnect the cable from the system board connector (1).

6. Remove the two Torx screws (2) that secure the power supply to the computer.
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7. Lift the power supply from the computer (3).

To install the power supply, reverse the removal procedures.
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Side panels
Description

Left side panel

Right side panel

The side panels are located one each side of the computer. They are secured with tabs, and the removal
procedures are similar for both panels.

To remove the side panels:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the optical drive (see Replacing the optical drive on page 39).

5. Remove the top rear trim (see Top rear trim on page 54).

6. Remove the lower rear panel (see Lower rear panel on page 59).
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7. Two tabs secure both the left and right side panels to the computer. Press both tabs to disengage the
panel, and rotate the panel off the computer.

NOTE: The removal and replacement procedures are similar for both panels. Right panel (when
viewed from behind) shown in the following images.

To install the side panels, reverse the removal procedures.

ENWW Side panels 77



System board
Description

System board for use in models without Windows 8

System board for use in models with Windows 8 Standard

System board for use in models with Windows 8 Professional

The system board is located on the right side of the computer (viewed from the rear). It is secured with ten
Torx screws, two of which also secure the removable outside bracket.

To remove the system board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the ride side panel (see Side panels on page 76).

5. Remove the lower rear panel (see Lower rear panel on page 59).

6. Remove the VESA mounting plate (see VESA mounting plate on page 72).

7. Remove the memory modules (see Memory on page 44).

8. Remove the processor heat sink (see Heat sink on page 51).

9. Remove the processor (see Processor on page 53).

10. Remove the WLAN module (see WLAN module on page 49).
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11. Disconnect all cables from the system board, noting their location for reinstallation.

12. Remove the side bracket by removing the two Torx screws (1), and then rotating the bracket to remove
it (2).
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13. Remove the eight remaining Torx screws that secure the system board to the computer.

14. Position the cables on the side of the board out of the way so you can freely slide the board out of the
computer.

15. Slide the system board toward the top of the computer, and then lift it out of the computer.

To install the system board, reverse the removal procedures.

Replace the thermal pad below the system board.

Updating the display panel manufacturer setting in BIOS

After replacing the system board, make sure the display panel manufacturer setting is correct in BIOS. If the
incorrect panel manufacturer is set in BIOS, the display panel may function incorrectly.

The display panel manufacturer is identified on the jumper setting label on the base pan.

After confirming the manufacturer of the display panel on the computer, go into BIOS and make sure the
LVDS Panel Select setting is correct.

To update BIOS with display panel model information:

1. Boot the computer.

2. Repeatedly press F10 when the monitor light turns green to access the F10 Setup utility.
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3. Select Advanced, select Device Options, select LVDS Panel Select, and then select the manufacturer
for the new display panel.

4. Save your settings, exit F10 Setup, and allow the computer to continue to the operating system.

When you change the LVDS setting to the installed panel type, the BIOS reprograms the EDID with the correct
data. You must set the panel before the Auto-select setting functions correctly.

Updating SMBIOS Information

When replacing the system board, you must reprogram the SMBIOS information on the affected computer.
Failure to reprogram the board will result in eventual failure, such as an activation failure (need to reactivate
the system) or a system recovery failure.

To update SMBIOS information in Computer Setup:

1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and again press
Esc when the monitor light turns green to access the utility.

3. Press F10 to enter Computer Setup.

4. Go to Security > System ID’s.

5. If necessary, press Ctrl+A to initiate edit mode.

6. Edit the fields listed. If the feature byte has data or is not editable, then it was not cleared and cannot be
edited.

System ID Setup Page

Setup Field Name Comment Label

Product Name Enter the Model name/number or marketing name. Flexbuild

Serial Number Enter the Serial Number of Unit. Support

SKU Number Enter the SKU or Product Number including Localization Code. Support

Asset Tag Enter the 18-byte identifier assigned to the computer. Support

Feature Byte Enter the Feature Byte string. The feature byte string is case sensitive.

The label includes spaces after every four characters. You can enter or ignore
these spaces – their only purpose is to help with data entry. There is a character
limitation of 40 bytes per line. When you reach this limit, go to the next line to
continue data entry. BIOS ignores the spaces and lines.

If you make an error during data entry, the data will not validate, and the
computer asks you to correct your data input.

Flexbuild

Build ID The Build ID of the unit. Flexbuild
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System board callouts

Sys Bd Label Color Component  Sys Bd Label Color Component

M.2 Black M.2 SSD drive  SATAPWR0 Black Hard drive power
connector

WEBCAM Black Webcam connector  SATA0 Dark blue Hard drive

XU1 Black Processor socket  PWR White Main power connector

X1PCIEXP12 Black Card reader connector  VGA Black Display connector

DIMM3 Black Memory module  DPCONV Black Converter board
connector

DIMM1 Black Memory module  SATA1 White Second hard drive
connector

CMOS Yellow Reset CMOS  SATA2 Black Optical drive connector

PSWD Green Clear system passwords  CPUFAN White Fan connector
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SPKR Black Speaker  CHFAN Black Fan connector

NFC Black NFC connector  SATAPWR2 Black Optical drive power
connector

BATTERY Black RTC battery  LVDS Black Display connector

HSENSE Black Hood sensor connector  J105 Black WLAN module connector

PB/LED Black Power switch connector     
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Card reader board
The card reader board is located on the right side of the system board. You must remove the system board
before you can remove the card reader board. The card reader board is secured with two screws.

To remove the card reader board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the ride side panel (see Side panels on page 76).

5. Remove the lower rear panel (see Lower rear panel on page 59).

6. Remove the VESA mounting plate (see VESA mounting plate on page 72).

7. Remove the memory modules (see Memory on page 44).

8. Remove the processor heat sink (see Heat sink on page 51).

9. Remove the processor (see Processor on page 53).

10. Remove the WLAN module (see WLAN module on page 49).

11. Remove the system board (see System board on page 78).

12. Remove the two Phillips screws that secure the board to the system board.

13. Position the system board upright with the right side toward you.
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14. Lift the board to a 45-degree angle, and then pull it away to remove it from the socket (2).

To install the card reader board, reverse the removal procedures.

Front bezel and display panel
The front bezel is located on the front of the computer and is secured to the main system frame with 15 Torx
screws.

Replacement bezels include the webcam shutter and capacitive sensor board. On models that do not include
a webcam, you must remove the shutter and install the webcam cover (Assembly kit) into the slot in which
the webcam would be installed.

Display panels require a backlight cable specific to the manufacturer. Make sure you use the backlight cable
packaged with the display panel.

To remove the front bezel:

1. Remove the stand (see Stand on page 29).

2. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

3. Remove the access panel (see Access panel on page 33).

4. Remove the webcam (see Webcam module on page 55).

5. Remove the optical drive (see Replacing the optical drive on page 39).

6. Remove the top rear trim (see Top rear trim on page 54).

7. Remove the lower rear panel (see Lower rear panel on page 59).

8. Remove the side panels (see Side panels on page 76).

9. Remove the speakers (see Speakers on page 63).

10. Remove the power button board (see Power button board on page 68).

11. Remove the Torx screws that secure the bezel to the main system frame assembly, as follows:

● 15 total screws:
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◦ Left: 4 screws

◦ Top: 2 screws

◦ Right 4 screws

◦ Bottom: 2 screws

◦ Interior: 3 screws (circled in image; these screws secure the display panel to the frame)

86 Chapter 5   Removal and Replacement Procedures ENWW



12. Lift the frame from the display panel and bezel.

The following image illustrates the frame removed from the display/bezel.
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13. Disconnect the backlight cable from the display panel.

NOTE: Replace the backlight cable with the new backlight cable that comes with the new display panel
kit.

Remove the backlight cable from the defective panel before sending the panel back to the supplier.

14. Separate the display panel from the bezel.
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15. The display panel cable is connected to the bottom of the panel. After lifting the panel up from the
bezel, look underneath to see the connected display panel cable. Lift the cable from the bottom of the
panel to disengage it from the adhesive that secures it to the panel, and then disconnect the display
cable from the display panel by pressing in on the tabs on the side of the connector, and then pulling
the cable from the connector.

To install the front bezel, reverse the removal procedures.

Be sure to correctly position the jumpers on the converter board for the installed display panel. The jumper
settings are shown on a label near the converter board.
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CAUTION: Incorrect jumper placement can result in damage to the converter board and display panel.

To install a display panel, reverse the removal procedures.

Updating BIOS with new display panel information

If you install a display panel from a different manufacturer than what was previously installed (for example,
replace an LG panel with a Samsung panel), you need to update BIOS with the new panel information. Failure
to do so may cause the new panel to function incorrectly.

To update BIOS with the new panel model information:

1. Boot the computer.

2. Repeatedly press F10 when the monitor light turns green to access the F10 Setup utility.

3. Select Advanced, select Device Options, select LVDS Panel Select, and then select the manufacturer
for the new display panel.

4. Save your settings, exit F10 Setup, and allow the computer to continue to the operating system.

When you change the LVDS setting to the installed panel type, the BIOS reprograms the EDID with the correct
data. You must set the panel before the Auto-select setting functions correctly.
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Hard drive and optical drive cables and connectors
Description

Optical drive cable (data and power assembly)

Hard drive cable (data and power assembly)

The hard drive and optical drive connectors are located near the middle of the computer, partially under the
main frame. Each connector is secured with two Torx screws and has two cables that connect to the system
board.

To remove the hard drive or optical drive connector:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 27).

2. Remove the stand (see Stand on page 29).

3. Remove the access panel (see Access panel on page 33).

4. Remove the ride side panel (see Side panels on page 76).

5. Remove the lower rear panel (see Lower rear panel on page 59).

6. Remove the VESA mounting plate (see VESA mounting plate on page 72).

7. Remove the memory modules (see Memory on page 44).

8. Remove the processor heat sink (see Heat sink on page 51).

9. Remove the processor (see Processor on page 53).

10. Remove the WLAN module (see WLAN module on page 49).

11. Remove the system board (see System board on page 78).

12. Remove the front bezel and display panel (see Front bezel and display panel on page 85).

13. Remove two Torx screws that secure the hard drive connector or the optical drive connector to the
computer.

14. Remove the cables from the metal clips built into the computer.

15. Disconnect the hard drive cables or the optical drive cables from the system board.

NOTE: Be careful not to damage the cable when disconnecting it from the board. Do not pull on the
wires.
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16. Remove the connector from the computer.

To install the hard drive or optical drive connector, reverse the removal procedures.
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6 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run during a
Full Boot. You can set the system to:

■ always Quick Boot (default);

■ periodically Full Boot (from every 1 to 30 days); or

■ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test (POST)
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of
the mode selected. To manually switch to Post Messages Enabled during POST, press any key (except
F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during power-
on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or embedded NIC,
so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

ENWW Computer Setup (F10) Utilities 93



● Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test
(POST).

● Replicate the system setup by saving system configuration information on a USB device and restoring it
on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities
Computer Setup can be accessed only by turning the computer on or restarting the system. To access the
Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, Power,
and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press
Esc.

5. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10
Setup screen.
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-1  Computer Setup—File

Option Description

System Information Lists:

● Product name

● Manufacturer

● SKU number

● Processor type/speed/stepping

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● Chassis serial number

● Asset tracking number

● System Board ID

● System Board CT Number

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on removable media or on a
network.

Replicated Setup Save to Removable Storage Device

Saves system configuration to a formatted USB flash media device.

Restore from Removable Storage Device

Restores system configuration from a USB flash media device.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and Exit Applies the currently selected default settings and clears any established passwords.

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-2  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options may be
presented:

● Hard Disk: Size, model, firmware version, serial number, connector color.

◦ M.2: Size, model, firmware, serial connector color, SMART.

◦ SATA0: Size, model, firmware, serial connector color, SMART.

◦ SATA1: Size, model, firmware, serial connector color, SMART.

● CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-ROM).

Storage Options SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system. There
are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and degrade or
corrupt established volumes.

IDE - This is the most backwards-compatible setting of the three options. Operating systems usually do
not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver loaded in
the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage of
more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/AHCI
volume. If you attempt to boot from a RAID/AHCI volume without the required device driver installed, the
system will crash (blue screen). RAID volumes may become corrupted if they are booted to after disabling
RAID.

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.
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Table 6-2  Computer Setup—Storage (continued)

Boot Order Allows you to:

● UEFI Boot Sources: Specify the order in which UEFI boot sources (such as a internal hard drive, USB
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for consideration as a
bootable operating system source.

UEFI boot sources always have precedence over legacy boot sources.

● Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network interface
card, internal hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in the
boot sequence and will be recognized as drive C (if any devices are attached).

 NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a
bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable UEFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot
menu) when the monitor light turns green. After POST is completed, a list of bootable devices is
displayed. Use the arrow keys to select the preferred bootable device and press Enter. The computer then
boots from the selected non-default device for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-3  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the ROM, and
make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears after a
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to change
resource settings for serial and parallel ports).

● Stringent security (enabling the stringent password disables the ability to reset the password by
moving the jumper on the system board). Default is disabled.

CAUTION: If you enable the stringent security feature and you forget the setup password or the
power-on password, the computer is inaccessible and can no longer be used.

If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing, the F10
Setup Options without entering setup password). Default is enabled.

● Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is
enabled.

● Network Server Mode. Default is disabled.

Smart Cover Allows you to:

● Lock/unlock the Cover Lock.

● Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been removed. Setup
Password requires that the setup password be entered to boot the computer if the sensor detects that
the cover has been removed.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● Embedded security device

● System audio

NOTE: Set this value to ‘Device hidden’ to disable all system volume.

● Network controller

NOTE: You must disable AMT before trying to hide the network controller.

● SATA ports (varies by model)
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Table 6-3  Computer Setup—Security (continued)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

● Rear USB Ports

● Accessory USB Ports

Slot Security Allows you to disable any PCI Express slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network server.
(Feature available on NIC models only; the network controller must be either a PCI expansion card or
embedded on the system board.) Default is enabled.

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current chassis
serial number is invalid. (These ID numbers are normally set in the factory and are used to uniquely
identify the system.)

● Keyboard locale setting for System ID entry.

Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data stored on
the disk. Master Boot Record Security may prevent unintentional or malicious changes to the MBR, such
as those caused by some viruses or by the incorrect use of certain disk utilities. It also allows you to
recover the "last known good" MBR, should changes to the MBR be detected when the system is
restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current
bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot
prevent changes that may occur while the operating system is running.

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.

Only appears if all of the following conditions are true:

● MBR security is enabled

● A backup copy of the MBR has been previously saved

● The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified the
MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved MBR if you
are confident that the current bootable disk's MBR has been corrupted or infected with a virus.
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Table 6-3  Computer Setup—Security (continued)

System Security (these
options are hardware
dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches. Default
is enabled.

SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor. Changing
this setting requires turning the computer off and then back on. Default is disabled.

Embedded Security Device (enable/disable) - Permits activation and deactivation of the Embedded
Security Device.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all security
keys and leave the device in a disabled state. Changing this setting requires that you restart the
computer. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security Device.
Choosing Reset to Factory Settings may result in significant data loss.

● Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path and
saves collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker tracks
changes to any of these metrics, and forces the user to re-authenticate if it detects any changes.
Enabling this feature lets you set Bitlocker to ignore detected changes to boot path metrics, thereby
avoiding re-authentication issues associated with USB keys inserted in a port. Default is enabled.

OS management of Embedded Security Device (enable/disable) - This option allows the user to limit OS
control of the Embedded Security Device. Default is enabled. This option is automatically disabled if
Trusted Execution Technology is enabled.

● Reset of Embedded Security Device through OS (enable/disable) - This option allows the user to
limit the operating system ability to request a Reset to Factory Settings of the Embedded Security
Device. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

● No PPI provisioning (Windows 8 only) - This option lets you set Windows 8 to bypass the PPI
(Physical Presence Interface) requirement and directly enable and take ownership of the TPM on
first boot. You cannot change this setting after TPM is owned/initialized, unless the TPM is reset.
Default is disabled for non-Windows 8 systems, and enabled for Windows 8.

● Allow PPI policy to be changed by OS. Enabling this option allows the operating system to execute
TPM operations without Physical Presence Interface. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

● Button Retask Password Protection (enable/disable) - Controls whether the Setup password must
be provided to WMI methods used to retask the function of the side panel buttons.
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Table 6-3  Computer Setup—Security (continued)

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is enabled,
the user is prompted to provide one of the DriveLock passwords during POST. If neither is successfully
entered, the hard drive will remain inaccessible until one of the passwords is successfully provided during
a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature is
attached to the system.

Secure Boot
Configuration

This is a feature of Windows 8.

● Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so on. If set
to disable, legacy boot options in Storage > Boot Order are not displayed. Default is enabled.

● Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate before
booting to it, making Windows resistant to malicious modification from preboot to full OS booting,
preventing firmware attacks. UEFI and Windows Secure Boot only allow code signed by pre-
approved digital certificates to run during the firmware and OS boot process. Default is disabled,
except for Windows 8 systems which have this setting enabled. Secure Boot enabled also sets
Legacy Support to disabled.

● Key Management—This option lets you manage the custom key settings.

◦ Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded custom
boot keys. Default is Don't Clear.

◦ Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify the
contents of the secure boot signature databases and the platform key (PK) that verifies
kernels during system start up, allowing you to use alternative operating systems. Selecting
HP Keys causes the computer boot using the preloaded HP-specific boot keys. Default is HP
Keys.

● Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f keys
to access items before the operating system loads. Default is disabled.

NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically and
display advanced boot options.

From Windows 8, you can press Shift and select Restart to access the screen that lets you boot to a
device or troubleshoot your computer.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-4  Computer Setup—Power

Option Description

OS Power Management ● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern. Default
is disabled.

NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4 state,
not the S5 state.

◦ S0 (On) = Solid white LED.

◦ S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white LED)
— repeated cycles of 3 blinks and a pause.

◦ S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white
LED) — repeated cycles of 4 blinks and a pause.

◦ S5 (Soft Off) = LED is off.

● ACPI S3 PS2 Mouse Wake Up—Enable/Disable. Enables or disables waking from S3 due to any PS2
mouse activity or a button click only.

● USB Wake on Device Insertion—Enable/Disable. Allows system to wake from Standby on USB device
insertion.

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management. Default is
enabled.

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to meet
EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically controlled.
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 6-5  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

◦ QuickBoot (default) = Do not clear memory or perform a memory test.

◦ FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦ Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦ FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

● POST messages (enable/disable). Enabling this feature will cause the system to display POST error
messages, which are error messages displayed on the monitor during the Power On Self Test if the
BIOS encounters some kind of problem while starting the PC. A POST error message will only display
on screen if the computer is capable of booting this far. If the POST detects an error before this
point, a beep code is generated instead. Default is disabled.

● Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of the text
“Press the ESC key for Startup Menu” during POST. This text does not display on Windows 8 systems
with Fast Boot support. Other text also will not display (for example, Ownership Tag). Default is
enabled.

● Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. Default is enabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is restored,
if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able to
use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST process.
This delay is sometimes needed for hard disks on some PCI cards that spin up very slowly, so slowly
that they are not ready to boot by the time POST is finished. The POST delay also gives you more
time to select F10 to enter Computer (F10) Setup. Default is None.

● Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

● Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect the
boot to the recovery partition on the user hard drive, if present. Some versions of the recovery
software honor the F11 key press even when this feature is disabled by the BIOS. Default is
disabled.

● Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the computer not
to confirm when changes were made. Default is disabled.

● POST Memory Manager Runtime Allocation (Enable/Disable).

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.
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Table 6-5  Computer Setup—Advanced (for advanced users) (continued)

Onboard Devices Allows you to set resources for or disable Legacy devices.

Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all operating
systems. To hide a device from the operating system, see Security > Device Security.

Bus Options Allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration space; only
needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Video (enable/disable). Use this option to disable the integrated video controller when
another video controller is present in the system. Default is enabled.

● LVDS Panel Select (Auto-select, LG, Samsung). Use this option to select the display panel
manufacturer. When you change the LVDS setting to the installed panel type, the BIOS reprograms
the EDID with the correct data. You must set the panel before the Auto-select setting functions
correctly.

● Integrated Video. Use this option to manage graphics memory allocation. The value you choose is
allocated permanently to graphics and is unavailable to the operating system. For example, if you
set this value to 512M on a system with 2 GB of RAM, the system always allocates 512 MB for
graphics and the other 1.5 GB for use by the BIOS and operating system. Default is Auto which sets
memory allocation to 512 MB.

If you select Selectable UMA Size, the UMA Frame Buffer Size option displays, which lets you set the
UMA memory size allocation between 32 MB and 2 GB.

● Internal Speaker (does not affect external speakers). Default is enabled.

● USB Charging Port (enable/disable). Use this option to disable the USB charging port.

● NFC Device (enable/disable). Allows yoo to enable or disable the near field communication device.

● Integrated Audio (enable/disable). Allows you to enable or disable the onboard Audio controller.

● Monitor Tracking (enable/disable). Allows BIOS to save monitor asset information.

PCI/VGA Configuration Displayed only if there are multiple PCI video adapters in the system. Allows you to specify which VGA
controller will be the "boot" or primary VGA controller.

NOTE: To see this entry, you must enable Integrated Video (Advanced > Device Options) and Save
Changes and Exit.
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Table 6-5  Computer Setup—Advanced (for advanced users) (continued)

CPM Option Allows you to set:

● Special Display Features (disabled, HCF_dGPU, Surround View, PowerXpress).

● Primary Video Adapter (Int Graphics (IGD), Ext Graphics (PEG), Auto).

● Skip SSD Override (enable/disable).

● Unused GPP Clocks Off (enable/disable).

● Brightness Control Method (VGA Driver, Video BIOS).

● Clock Power Management(CLKREQ#) (enable/disable).

● Thermal Fan Control (auto, disabled)

● GFX LINK CFG: x16, 2 x8-OnboardLanSwitch: (enable/disable).

● MiniPcieSlot (enable/disable).

● WirelessLanRf (enable/disable).

● DDI port detection (enable/disable).

● Adaptive S4 Control (disabled, enabled with EC Method, enabled with RTC Method).

Management Operations Allows you to set:

● DASH Support (enable/disable). Allows the DASH firmware to be Enabled/Disabled. If enabled, then
DASH Console Redirection, ASF BIOS Mode, and ASF Watchdog Timer become active.

● MCTP Support (enable/disable). Lets you enable Management Component Transport Protocol.

● DASH Console Redirection (enable/disable). If enabled, then DASH Terminal Type becomes active.

● DASH Terminal Type (VT100, VT200+, VT-UTF8, ANSI).

● ASF BIOS Mode (ON, OFF, Alert Only).

● ASF Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system and
BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is deactivated by
BIOS and would indicate that a halt occurred during execution if the alert is sent to the management
console. An operating system alert is deactivated by the operating system image and would indicate
that a hang occurred during its initialization. Default is enabled.

Option ROM Launch
Policy

(Windows 8 only). Windows 8 installs as a UEFI operating system (as opposed to ‘legacy’), and ships with
the ‘Legacy Support’ setting off in the BIOS. When ‘Legacy Support’ is off, the Option ROM Launch Policies
are set to ‘UEFI Only’. These policies control whether the Legacy Option ROM or the UEFI driver is loaded
for the following features:

● PXE Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy option ROM or the UEFI
driver in the BIOS is used to provide PXE services.

● Storage Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy option ROM or the
UEFI driver in the BIOS is used to provide RAID setup and support.

● Video Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy VBIOS or the UEFI driver
in the BIOS is used to provide graphics setup and support.

Connected BIOS Enables or disables the feature that updates the BIOS using the network.

● Connected BIOS (Enabled/Disabled). Enables or disables BIOS network support. Default is enabled.

● Use Proxy (Enabled/Disabled). When enabled, displays Proxy Address field to configure the URL of
the proxy server. Default is disabled.
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Table 6-5  Computer Setup—Advanced (for advanced users) (continued)

Update BIOS via Network Allows you to use F10 Setup to check for BIOS updates from hp.com and apply them using either a
manual selection or an automatically scheduled check on boot-up.

NOTE: If Windows BitLocker Drive Encryption (BDE) is enabled, HP requires that BDE be suspended
temporarily before the BIOS is flashed. You must get the BDE recovery password and PIN before
suspending BDE. After updating the BIOS, you can resume BDE.

● Update BIOS via Network (Enabled/Disabled). Enables or disables BIOS network support. Default is
enabled.

● Update Source (HP/Custom). Selects hp.com or a locally managed custom address to serve BIOS
updates. Default is HP.

Update Address. If Custom is selected for Update Source, the URL of the locally managed server.

● Automatic BIOS Update Setting (Disabled, Check and install all updates automatically, Check and
install only important updates automatically, Check for updates but let me decide whether to install
them). Enables or disables the network BIOS update scheduler. Default is disabled.

Automatic Update Frequency (Daily, Weekly, Monthly). Sets the frequency of checks to the BIOS
update server. If a newer version of BIOS is available on the network server, the system will prompt
to update the BIOS. Default is Monthly.

Force Check on Next Reboot (Disabled/Enabled). During the next boot, checks whether an updated
BIOS is available. This value is independent of the Automatic Update Frequency setting. Default is
disabled.

Ethernet Connection Provides information about the network connection.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command with the
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File on page 95 in the
Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a USB flash media
device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and perform the
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup—File
on page 95 in the Computer Setup—File table.)
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7 HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP
includes on all products. This tool can even be used if the computer will not boot to the operating system.

Why run HP PC Hardware Diagnostics
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite the
support process when issues are found. The tools save time by pinpointing the component that needs to be
replaced.

● Isolate true hardware failures: The diagnostics run outside of the operating system so they effectively
isolate hardware failures from issues that may be caused by the operating system or other software
components.

● Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID is
generated. This ID can then be provided to the call agent, who will either schedule support or provide
replacement parts.

How to access and run HP PC Hardware Diagnostics
You can run the diagnostics from one of three places, depending on your preference and the health of the
computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.

2. Press F2 or select Diagnostics (F2).

Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions in
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 108)

b. The hard disk drive

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible only if
the USB or hard disk drive versions are not detected
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Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardward Diagnostics to USB device.

Option 1: HP PC Diagnostics homepage–Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages–Provides downloads for a specific product for earlier and later
versions.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.
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8 Troubleshooting without diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices, hard
drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems with the
computer, refer to the tables in this chapter for probable causes and recommended solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On Self-
Test (POST) at startup, refer to Appendix A, POST error messages on page 157.

Safety and comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may
result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for
more information on choosing a workspace and creating a safe and comfortable work environment. For more
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact
problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 93 for
more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to Appendix A, POST error messages on page 157
for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is available. Or,
replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions properly.

● If you recently installed new software, uninstall the software and see if the computer functions
properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting
the operating system, use “Last Known Configuration.”
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● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful hints on page 110 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with self-
solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online
chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your
service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before
running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

● Check that the computer is turned on and the white power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to Appendix A, POST error messages on page 157
for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard or pressing the power button. If the system
remains in suspend mode, shut down the computer by pressing and holding the power button for at

110 Chapter 8   Troubleshooting without diagnostics ENWW

http://www.hp.com/support
http://www.hp.com/go/ispe
http://www.hp.com/go/bizsupport


least four seconds then press the power button again to restart the computer. If the system will not
shut down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if
it is set to power on automatically as soon as power is restored in Computer Setup. If it does not restart,
press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option. See
Solving hardware installation problems on page 131 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a printer,
you need a driver for that model printer.

● Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

● If you have installed an operating system other than the factory-installed operating system, check to be
sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed (embedded
video on some models only) and a single monitor, the monitor must be plugged into the monitor
connector on the source selected as the primary VGA adapter. During boot, the other monitor
connectors are disabled and if the monitor is connected into these ports, the monitor will not function.
You can select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to the
system board. You must disconnect the power cord from the power source before opening the computer to
prevent system board or component damage.
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Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem persists and
you are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an
authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet prolongs the
life of the RTC battery.

Reset the date and time under Control Panel (Computer Setup
can also be used to update the RTC date and time). If the problem
persists, replace the RTC battery. See the Removal and
Replacement section for instructions on installing a new battery,
or contact an authorized dealer or reseller for RTC battery
replacement.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start screen, type
c, and then select Control Panel from the list of applications.
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Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is turned on. Press the Num Lock key. The Num Lock light must be off if you
want to use the arrow keys on the keypad. You can also disable or
enable the Num Lock key in Computer Setup at Advanced >
Device Options.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is set
correctly.

3. Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock . A
key to unlock the Smart Cover Lock is not available from HP. Keys
are typically available from a hardware store.

Poor performance.

Cause Solution

Processor is too hot. 1. Make sure airflow to the computer is not blocked. Leave a
10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly (some
fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the
hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.
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Poor performance.

Cause Solution

Virus resident on the hard drive. Run virus protection program.

Too many applications running. Windows 7:

1. Close unnecessary applications to free up memory.

2. Add more memory.

3. Some applications run in the background and can be closed
by right-clicking on their corresponding icons in the task
tray. To prevent these applications from launching at
startup:

In Windows 7:

a. Go to Start > All Programs > Accessories > Run

b. Type msconfig, and then press Enter.

c. On the Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically, and the click OK.

In Windows 8:

a. On the Start screen, right-click, and then select the All
apps icon.

b. Under Windows System, click Run.

c. Type msconfig, and then press Enter.

d. On the Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically, and the click OK.

Some software applications, especially games, are stressful on
the graphics subsystem.

1. Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two second
pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the
processor cooling fan is running.

2. Open the access panel, press the power button, and see if
the processor fan (or other system fan) spins. If the fan does
not spin, make sure the fan cable is plugged onto the
system board header.

3. If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:

1. If equipped with a voltage selector, check that the voltage
selector (located on the rear of the power supply) is set to
the appropriate voltage. Proper voltage setting depends on
your region.

2. Remove the expansion cards one at a time until the 5V_aux
light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:

1. Check that the unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button
cable is properly connected to the system board.

3. Check that the power supply cables are properly connected
to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power button
assembly.

5. If the 5V_aux light on the system board is off, then replace
the power supply.

6. Replace the system board.
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Solving power problems
Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch on
rear of computer chassis (some models) not switched to correct
line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power supply
fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two second
pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and the
processor cooling fan is running.

2. Open the access panel, press the power button, and see if
the processor fan (or other system fan) spins. If the fan does
not spin, make sure the fan cable is plugged onto the
system board header.

3. If fan a plugged in and not spinning, replace it.

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps four times.
(Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. If equipped with a voltage selector, check that the voltage
selector, located on the rear of the power supply (some
models), is set to the appropriate voltage. Proper voltage
setting depends on your region.

2. Open the access panel and ensure the power supply cable is
seated into the connector on the system board.

3. Check if a device is causing the problem by removing ALL
attached devices (such as hard drives or optical drives and
expansion cards). Power on the system. If the system enters
POST, then power off and replace one device at a time and
repeat this procedure until failure occurs. Replace the
device that is causing the failure. Continue adding devices
one at a time to ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.
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Solving hard drive problems
Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Windows 7, click Start, click Computer, and right-click on
a drive. Select Properties, and then select the Tools tab.
Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then select
File Explorer from the list of applications. In the left
column, expand Computer, right-click on a drive, select
Properties, and then select the Tools tab. Under Error
checking click Check.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with a
file.

In Windows 7, click Start, expand Computer, and right-click on a
drive. Select Properties, and then select the Tools tab. Under
Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column, expand
Computer, right-click on a drive, select Properties, and then
select the Tools tab. Under Error checking click Check.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving hardware
installation problems on page 131 section. If the system still
does not recognize the new device, check to see if the device is
listed within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a hardware
problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced >
Power-On Options.
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Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

▲ Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed. 1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then select
the File Backup Program option, and then restore the
system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive entry in
the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard drive
configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order. Run the Computer Setup utility and select Storage > Boot Order
and ensure the bootable hard drive is listed immediately under
the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage  > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some models) Run the Computer Setup utility and change the “Emulation Type”
to “Hard Disk” in the device's details under Storage > Device
Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if any
beeps are heard. See Appendix A, POST error messages
on page 157 to determine possible causes for the blinking red
and beep codes.

See the Worldwide Limited Warranty for terms and conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not
respond.

2. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to
turn off the power. To restart the computer, press the
power button again.
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Solving media card reader problems
Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a capacity
greater than 32MB with the FAT32 format. Some digital cameras
use the FAT (FAT16 & FAT12) format and can not operate with a
FAT32 formatted card.

Either format the media card in the digital camera or select FAT
file system to format the media card in a computer with Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located on
the bottom of the Memory Stick/PRO card is not in the locked
position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your card
to see if it writable. Refer to the previous section for a list of
compatible cards.

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located on
the bottom of the Memory Stick/PRO card is not in the locked
position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the wrong
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact on
the correct side. The green LED will light if inserted properly.

ENWW Solving media card reader problems 119



Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on the
corresponding drive icon, and then select Eject. Pull the card out
of the slot.

In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer, right-
click on the corresponding drive icon, and then select Eject. Pull
the card out of the slot.

NOTE: Never remove the card when the green LED is flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by the
computer.

Cause Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are turning
the PC on for the first time.

Wait a few seconds so that the operating system can recognize
the reader and the available ports, and then recognize the media
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the common
causes and solutions listed in the following table.

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer and
to the electrical outlet.

You may have a screen blanking utility installed or energy saver
features are enabled.

Press any key or click the mouse button and type your password
(if set).
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Blank screen (no video).

Cause Solution

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan rate
as the resolution chosen.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Monitor cable is plugged into the wrong connector. Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the computer

Monitor settings in the computer are not compatible with the
monitor.

1. In Control Panel, select Category from the View by list, then
under Appearance and Personalization, select Adjust
screen resolution.

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the list
of applications.

2. Expand the Resolution box, and then use the sliding control
to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the computer
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2. Replace the graphics card (if applicable).

3. Replace the system board.

For systems with integrated graphics, replace the system board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and the computer
beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.
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The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor may
be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came with
the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu. Select
ImageControl/ Horizontal Position or Vertical Position to adjust
the horizontal or vertical position of the image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.
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“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the settings
to a supported setting then restart the computer so that the new
settings take effect.

To enter Safe Mode in Windows 7:

1. Restart the computer.

2. Press and hold the F8 key as your computer restarts, before
the Windows logo appears. If the Windows logo appears,
you must restart the computer and try again.

3. On the Advanced Boot Options screen, use the arrow keys to
highlight the safe mode option you want, and then press
Enter.

4. Log on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode displays in
the corners of your monitor. To exit safe mode, restart your
computer and let Windows start normally.

To enter Safe Mode in Windows 8:

1. Press the Windows logo + l to open the Settings charm.

2. Select Change PC Settings, select General, and then under
Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, select
Startup Settings, and then click Restart.

4. Use the function keys or number keys to select the safe
mode option you want.

When your computer is in safe mode, Safe Mode displays in
the corners of your monitor. To exit safe mode, restart your
computer and let Windows start normally.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may be
unable to correctly interpret the output synchronization of the
graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-screen
display functions. To download a SoftPaq that will assist
you with the synchronization, go to the following Web site,
select the appropriate monitor, and download either
SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad (some models). 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular symbol. Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map into a
document.

In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select Character
Map.

In Windows 8, on the Start screen, type ch, and then select
Character Map  from the list of applications.
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Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and solutions
listed in the following table.

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open applications. Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make sure
that Mute is not selected and use the volume slider to adjust the
volume.

NOTE: In Windows 8, the taskbar is available at the bottom of
the Desktop screen.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security > Device Security >
System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle. The
speakers should be plugged into the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a recently
installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green receptacle.

Headphones or devices connected to the line-out connector mute
the internal speaker.

Turn on and use headphones or external speakers, if connected,
or disconnect headphones or external speakers.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select Advanced
> Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.
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Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output connector.
The rear audio output connector is for powered audio devices and
is not designed for headphone use.

Plug the headphones into the headphone connector on the front
of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack or
set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.
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Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed. 1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type cmd
in the Open box, and then click OK.

If you are on a network, you may not have made the connection
to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it back
on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.
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Solving keyboard and mouse problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to
the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no
function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected USB
3.0 devices can interfere with the wireless keyboard USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0 port that
is separated from ports with USB 3.0 devices. If you still
experience interference, you may have to place the connectors
farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. Shut down the computer, reconnect the keyboard to the back of
the computer, and then restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is on. Press the Num Lock key. The Num Lock light should be off if you
want to use the arrow keys on the keypad. You can disable or
enable the Num Lock key in Computer Setup at Advanced >
Device Options.
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Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press
Enter.

3. After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Windows 8:

1. Press the Windows logo + l to open the Settings charm.

2. Use the arrow keys to select Power, and then press Enter.

3. Use the arrow keys to select Shut Down, and then press
Enter.

4. After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the internal
components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean
the internal components with a mouse cleaning kit available from
most computer stores.
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Solving hardware installation problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or
expansion card. If you install a plug and play device, Windows automatically recognizes the device and
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the
instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Table 8-1  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are
unplugged.

Ensure that all cables are properly and securely connected and
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings
for the board and choose a basic configuration that does not
cause a resource conflict. You can also use Computer Setup to
reconfigure or disable devices to resolve the resource conflict.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device available
is selected for appropriate USB ports under Security > USB
Security.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or memory
modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules and
to verify the proper installation.
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Computer will not start.

Cause Solution

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3. If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps
stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system board,
you must unplug the computer power cord before attempting to
reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six times. (Beeps
stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card (some models) is not seated properly or is bad, or
system board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system board.
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Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten times. (Beeps
stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at time (if
multiple cards), then power on the system to see if fault
goes away.

2. Once bad card is identified, remove and replace bad option
card.

3. Replace the system board.

Solving network problems
Some common causes and solutions for network problems are listed in the following table. These guidelines
do not discuss the process of debugging the network cabling.

Table 8-2  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer Setup.
Select Power > Hardware Power Management > S5 Maximum
Power Savings.

S5 Wake on LAN is disabled (some models). Enable the S5 Wake on LAN option in Computer Setup. Select
Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows 7:

1. Select Start > Control Panel > Network and Sharing Center.

2. Under Tasks, select Manage network connections.

3. Click Local Area Connection.

4. Click the Properties button.

5. Click the Configure button.

6. Click the Power Management tab, then select Allow this
device to wake the computer.

To enable Wake-on-LAN in Windows 8:

1. From the Start screen, type c, and then select Control Panel
from the list of applications.

2. Select Network and Sharing Center, and then click the
Ethernet link next to the connection.

3. Click the Properties button.

4. Click the Configure button.

5. Click the Power Management tab, then enable the
appropriate Wake-on LAN option.
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Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into the
correct operating mode.
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Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of
the cable.

Ensure that the cable and device at the other end are operating
correctly.

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource
settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network and Sharing Center icon in the Control Panel
and configure the network controller.

To access Control Panel in Windows 7, click Start, and then select
Control Panel.

To access Control Panel in Windows 8, from the Start screen, type
c, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the resource
settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the resource
settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 8.

If necessary, download the softpaq from the web (from a
different computer).
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Table 8-2  Solving Network Problems (continued)

Network controller stops working without apparent cause.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present, and
that the Remote System Installation Server contains the NIC
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on the
Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug the
computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME) enabled.
The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-channel mode to
download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-party data storage, and
other management functions.
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System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1 socket. Ensure that a memory module is installed in the DIMM1 or XMM1
socket on the system board. This socket must be populated with
a memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for the
computer. On some models, ECC and non-ECC memory modules
cannot be mixed.

Out of memory error.

Cause Solution

You have run out of memory to run the application. Check the application documentation to determine the memory
requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add more
memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps
stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving processor problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT (Trusted Execution Technology) capable
processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the following
table or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden in the
Computer Setup utility.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Security > Device Security.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable
media in Storage  > Storage Options. Ensure CD-ROM is enabled
in Storage > Boot Order.

Network Boot is enabled in Computer Setup. Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.
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Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving hardware
installation problems on page 131 section. If the system still does
not recognize the new device, check to see if the device is listed
within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a hardware
problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced  > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in Advanced >
Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove
the disc.
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CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media is corrupt. Try different media to confirm whether media is valid.

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine the
type of media being played. If the disc still does not start, read
the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

2. Restart the computer and let Windows detect the CD or DVD
driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following table.

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in
Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system
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System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup utility. Run the Computer Setup utility and enable booting to removable
media in Storage > Storage Options. Ensure USB is enabled in
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Flash drive is defective. Try a different flash drive.

Solving front panel component problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is connected
to the device and one end is connected to a live outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that the USB ports are
set to Enabled in Security > USB Security.

ENWW Solving front panel component problems 141



Need to disable the webcam.

Cause Solution

The webcam is enabled in F10 Setup. You can disable the webcam in F10 Setup by disabling accessory
USB port 5. Go to F10 Setup, then navigate to Security > USB
Security > Accessory USB Ports. Set the value for USB Port 5 to
Disabled. See Computer Setup—Security on page 98 for more
information.

Solving Internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up properly. Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work with
your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED light on
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to
bad weather.

Try connecting to the Internet at a later time or contact your ISP.
(If the cable/DSL service is connected, the “cable” LED light on the
front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem and the
computers’s RJ-45 connector. (If the connection is good, the “PC”
LED light on the front of the cable/DSL modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information
that a Web server can store temporarily with the Web browser.
This is useful for having the browser remember some specific
information that the Web server can later retrieve.)

Windows 7:

1. Select Start > Control Panel.

2. Click Internet Options.

3. In the Browsing history section on the General tab, click the
Delete button.

4. Select the Cookies check box and click the Delete button.

Windows 8:

1. From the Start screen, type c, and then select Control Panel
from the list of applications..

2. Click Internet Options.

3. In the Browsing history section on the General tab, click the
Delete button.

4. Select the Cookies check box and click the Delete button.

142 Chapter 8   Troubleshooting without diagnostics ENWW



Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.

Solving software problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system, check to be
sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the computer.
See Appendix A, POST error messages on page 157 to determine
possible causes.

See the Worldwide Limited Warranty for terms and conditions.
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Computer will not continue after HP logo screen displays.

Cause Solution

System files may be damaged. In Windows 7, use recovery media to scan hard drive for errors, or
use Windows Startup Repair to fix problems that might prevent
Windows from starting correctly. Windows Startup Repair is one
of the recovery tools in the System Recovery Options menu. You
can also create a system repair disc that contains the System
Recovery Options menu. If the problem is severe enough that
Startup Repair doesn't start on its own and you can't access the
System Recovery Options menu on your computer's hard disk,
you can get to the menu and start Startup Repair by using the
Windows installation disc or a system repair disc that you created
earlier.

In Windows 8, use Automatic Repair to fix problems that might
prevent Windows from starting correctly.

To access Automatic Repair:

1. Press the Windows logo + l to open the Settings charm.

2. Select Change PC Settings, select General, and then under
Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, and then
select Automatic Repair.

Windows starts Automatic Repair.

4. Select the account to use to begin Automatic Repair, and
type the password for the account.

Windows diagnoses the computer and attempts the repair
it.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your version of
Windows.

Verify that the software is certified by Microsoft for your version
of Windows (see program packaging for this information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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9 System backup and recovery

Backing up, restoring, and recovering in Windows 8
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working state
or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more details
about the tools provided, see Help and Support. From the Start screen, type h, and then select Help and
Support.

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This step creates a backup of the
recovery partition on the computer. The backup can be used to reinstall the original operating system in
cases where the hard drive is corrupted or has been replaced.

You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot a
Windows 8 computer that is unable to start. The USB flash drive can be used to reinstall the original
operating system and the programs that were installed at the factory.

NOTE: Any information on the USB flash drive will be erased before the recovery media is created.

To create the recovery media, from the Start screen, type recovery drive, and then click on
Settings, then click on Create a recovery drive. Follow the on-screen instructions to continue.

2. As you add hardware and software programs, create system restore points. A system restore point is a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows creates a
system restore point for you automatically during a Windows update and during other system
maintenance (such as a software update, security scanning, or system diagnostics). You can also
manually create a system restore point at any time. For more information and steps for creating
specific system restore points, see Windows Help and Support. From the Start screen, type h, and then
select Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal information.
Windows File History can be set to regularly and automatically back up files from libraries, desktop,
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contacts, and favorites. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can restore the files that you backed up
using File History. Restoring files is also useful if you ever choose to reset the computer by reinstalling
Windows. 

NOTE: File History is not enabled by default, so you must turn it on.

For more information and steps for enabling Windows File History, see Windows Help and Support.
From the Start screen, type h, and then select Help and Support.

Restoring and recovering using Windows 8 tools 
Windows recovery tools provide access to several options for recovering your system. Choose the method
that best matches your situation and level of expertise:

● If you need to restore your personal files and data, you can use Windows File History to restore your
information from the backups you created. For more information and steps for using File History, see
Windows Help and Support. From the Start screen, type h, and then select Help and Support. 

● If you want to restore the system to a previous state without losing any personal information, Windows
System Restore is an option. System Restore allows you to restore without the requirements of
Windows Refresh or a reinstallation. Windows creates system restore points automatically during a
Windows update and other system maintenance events. Even if you did not manually create a restore
point, you can choose to restore to an automatically created restore point. For more information and
steps for using Windows System Restore, see Windows Help and Support. From the Start screen, type h,
and then select Help and Support.

● If you want a quick and easy way to recover the system without losing your personal information,
settings, or apps that came preinstalled on your computer or were purchased from the Windows Store,
Windows Refresh is an option. This method does not require backing up data to another drive. See Using
Windows 8 Refresh on page 146.

● If you want to reset your computer to its original state, Windows Reset provides an easy way to remove
all personal data, apps, and settings, and reinstall Windows. The Reset recovery tool reinstalls the
operating system and HP programs and drivers that were installed at the factory. Software not installed
at the factory must be reinstalled. Any personal files must be restored from backups you made. See
Using Windows 8 Reset on page 147.

● If the computer is unable to start, you can use the Windows recovery USB flash drive you created to
recover the system. See Recovery using the Windows 8 recovery USB flash drive on page 148.

● If the computer is unable to start and you did not create a recovery USB flash drive or the one you
created does not work, see Recovery using Windows 8 operating system media (purchased separately)
on page 148.

Using Windows 8 Refresh

NOTE: You may be prompted for your permission or password when using Refresh. See Windows Help and
Support for more information. From the Start screen, type h, and then select Help and Support.

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the system
at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a quick way
to see what you might need to reinstall. See Help and Support for instructions on reinstalling traditional
applications. From the Start screen, type h, and then select Help and Support.
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If Windows is responding, use these steps to start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General from the PC
settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the on-screen
instructions.

If Windows is not responding, use these steps to start Refresh:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and then
select Computer

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover
using the recovery media you created; see Recovery using the Windows 8 recovery USB flash drive
on page 148. Or you must use the Windows 8 operating system media and the Driver Recovery media
(purchased separately); see Recovery using Windows 8 operating system media (purchased separately)
on page 148

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the company logo is
displayed. The computer Startup Menu displays.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.

7. Select Refresh.

8. Follow the on-screen instructions to continue.

Using Windows 8 Reset

NOTE: You may be prompted for your permission or password when using Reset. See Windows Help and
Support for more information. From the Start screen, type h, and then select Help and Support.

IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you wish to retain.

If Windows is responding, use these steps to start Reset:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General from the PC
settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the on-screen
instructions.
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If Windows is not responding, use these steps to start Reset:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and then
select Computer.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover
using the recovery media you created; see Recovery using the Windows 8 recovery USB flash drive
on page 148. Or you must use the Windows 8 operating system media and the Driver Recovery media
(purchased separately); see Recovery using Windows 8 operating system media (purchased separately)
on page 148.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the company logo is
displayed. The computer Startup Menu displays.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.

7. Select Reset.

8. Follow the on-screen instructions to continue.

Recovery using the Windows 8 recovery USB flash drive

To recover your system using the recovery USB flash drive you previously created:

NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see Recovery
using Windows 8 operating system media (purchased separately) on page 148.

1. If possible, back up all personal files.

2. Insert the recovery USB flash drive you created into a USB port on your computer.

3. Restart the computer and as soon as you see the HP logo screen, press f9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press Enter
to boot from that device.

4. Choose your keyboard layout.

5. Select Troubleshoot.

6. Select Refresh your PC.

7. Follow the on-screen instructions.

Recovery using Windows 8 operating system media (purchased separately)

This recovery process requires Windows 8 operating system media, which can be ordered from the support
website. For U.S. support, go to http://www.hp.com/support. For worldwide support, go to
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http://welcome.hp.com/country/us/en/wwcontact_us.html. You can also order the media by calling support.
For contact information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using Windows 8 operating system media completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.

To initiate recovery using Windows 8 operating system media:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows 8 operating system
media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed and the Windows 8 desktop appears:

1. Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Backing up, restoring, and recovering in Windows 7
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working state
or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more details
about the Windows Backup and Restore tools provided, see Help and Support. To access Help and Support,
select Start > Help and Support.

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced. See
Creating recovery media on page 150.

2. As you add hardware and software programs, create system restore points. A system restore point is a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows creates a
system restore point for you automatically during a Windows update and during other system
maintenance (such as a software update, security scanning, or system diagnostics). You can also
manually create a system restore point at any time. For more information and steps for creating
specific system restore points, see Help and Support. To access Help and Support, select Start > Help
and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal information.
If files are accidentally deleted from the hard drive and they can no longer be restored from the Recycle
Bin, or if files become corrupted, you can restore the files that you backed up. In case of system failure,
you can use the backup files to restore the contents of your computer. See Backing up your information
on page 152.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Creating recovery media
After you successfully set up the computer, create recovery media. The media can be used to reinstall the
original operating system in cases where the hard drive is corrupted or has been replaced.

There are two types of recovery media. To determine which steps to follow for your computer:

1. Click the Start button.

2. Click All Programs.

● If Security and Protection is listed, continue with the steps in Creating recovery media using HP
Recovery Manager (select models only) on page 151.

● If Productivity and Tools is listed, continue with the steps in Creating recovery discs with HP
Recovery Disc Creator (select models only) on page 152.
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Creating recovery media using HP Recovery Manager (select models only)

● To create recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs (purchased
separately). The discs you use will depend on the type of optical drive you are using.

NOTE: DVD+R DL, DVD-R DL, or DVD±RW disc are not supported.

● You have the option of creating a recovery USB flash drive instead, using a high-quality USB drive.

● If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to reject
defective discs. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6 DVDs).
The Recovery Media Creation program tells you the specific number of blank discs needed to make the
set. If you are using a USB flash drive, the program will tell you the size of the drive required to store all
the data (minimum of 8 GB).

NOTE: The process of creating recovery media is lengthy. You can quit the process at any time. The
next time you initiate the process, it resumes where it left off.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up from a
media card and you may not be able to run system recovery.

To create recovery discs:

1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and
then click HP Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1, Recovery
2), and then store the discs in a secure place.

To create a recovery USB flash drive:

NOTE: You must use a USB flash drive with a capacity of at least 8 GB.

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and
then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage is
required to create the recovery drive. If the USB flash drive does not have enough storage capacity, it
will appear grayed out, and you must replace it with a larger USB flash drive. Click Next.

NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and store it
in a secure place.
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Creating recovery discs with HP Recovery Disc Creator (select models only)

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs on
select models. After you successfully set up the computer, you can create recovery discs using HP Recovery
Disc Creator. The recovery discs allows you to reinstall your original operating system as well as select
drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator creates two kinds of
recovery discs:

● Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

● Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

To create recovery discs, your computer must have a DVD writer. Use any of the following types of discs
(purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive you are using.

Creating recovery discs

NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that
media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it in a
secure place.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it in a
secure place.

Backing up your information

You should create your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably current
backup. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.
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● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password. Refer to Help and Support. To access Help and Support,
select Start > Help and Support.

To create a backup using Windows Backup and Restore: 

NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup.

System Restore
If you have a problem that might be due to software that you installed on your computer, or if you want to
restore the system to a previous state without losing any personal information, use System Restore to return
the computer to a previous restore point.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen instructions.

System Recovery

WARNING! This procedure will delete all user information. To prevent loss of information, be sure to back
up all user information so you can restore it after recovery.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you have
created, and then reinstalls the operating system, programs, and drivers. However, you must reinstall any
software that was not installed on the computer at the factory. This includes software that came on media
included in the computer accessory box, and any software programs you installed after purchase. Any
personal files must be restored from backups you made.

If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc set
from support. For U.S. support, go to http://www.hp.com/support. For worldwide support, go to
http://welcome.hp.com/country/us/en/wwcontact_us.html. You can also order the recovery disc set by
calling support. For contact information, see the Worldwide Telephone Numbers booklet included with the
computer.

NOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 153.

You must choose one of the following methods to perform a System Recovery:
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● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive. The
recovery image is a file that contains a copy of the original factory-shipped software. To perform a
System Recovery from a recovery image, see System Recovery when Windows is responding
on page 154 or System Recovery when Windows is not responding on page 154.

● Recovery media — Run System Recovery from recovery media that you have created from files stored
on your hard disk drive or purchased separately. See System Recovery using recovery media (select
models only) on page 155.

System Recovery when Windows is responding

CAUTION: System Recovery deletes all data and programs you created or installed. Before you begin, back
up any important data to a CD or DVD or to a USB flash drive.

NOTE: In some cases, you must use recovery media for this procedure. If you have not already created this
media, follow the instructions in Creating recovery media on page 150.

If the computer is working and Windows 7 is responding, use these steps to perform a System Recovery:

1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.

4. When Windows has loaded, click the Start button, click All Programs.

● If Security and Protection is listed, continue with step 5.

● If Productivity and Tools is listed, follow the steps in System Recovery when Windows is not
responding on page 154.

5. Click Security and Protection, click Recovery Manager, and then click Recovery Manager. If prompted,
click Yes to allow the program to continue.

6. Under I need help immediately, click System Recovery.

7. Select Yes, and then click Next. Your computer restarts.

8. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I need
help immediately, click System Recovery. If you are prompted to back up your files, and you have not
done so, select Back up your files first (recommended), and then click Next. Otherwise, select Recover
without backing up your files, and then click Next.

9. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

10. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the
computer back on.

System Recovery when Windows is not responding

CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.
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3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5. At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the
computer back on.

System Recovery using recovery media (select models only)

Use the steps provided in this section if you created recovery media using Creating recovery media using HP
Recovery Manager (select models only) on page 151. If you used HP Recovery Disc Creator to create a
Windows 7 operating system DVD and a Driver Recovery DVD, use the steps in Using HP Recovery Disc
operating system discs (select models only) on page 155.

CAUTION: System Recovery deletes all data and programs you have created or installed. Back up any
important data to a CD or DVD or to a USB flash drive.

To perform a System Recovery using recovery media:

1. If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If you are
using a recovery USB flash drive, insert it into a USB port.

2. Click the Start button, and then click Shut Down.

or

If the computer is not responding, press and hold the power button for approximately 5 seconds or until
the computer turns off.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer, and press Esc as the computer is powering on to
display the startup menu.

5. Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the location
where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select Media.
On the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files first
(recommended), and then click Next. Otherwise, select Recover without backing up your files, and
then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive from the
system.

10. Click Finish to restart the computer.

Using HP Recovery Disc operating system discs (select models only)

Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7 operating
system DVD and a Driver Recovery DVD. If you created recovery media using Creating recovery media using
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HP Recovery Manager (select models only) on page 151. use the steps in System Recovery using recovery
media (select models only) on page 155.

If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the
operating system.

To order a Windows 7 operating system DVD and Driver Recovery DVD, go to the HP website. For U.S. support,
go to http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVDs by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before
the Windows operating system loads.

NOTE: If the computer does not boot to the DVD, restart the computer and press Esc as the computer
is powering on to see the startup menu. Use the arrow keys to select the boot menu and press Enter.
Use the arrow keys to select the location where the recovery DVD is inserted. Press Enter to boot from
that device.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6.
Select Install now.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install
Recommended Applications.
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10 POST error messages

This appendix lists the error codes, error messages, and the various indicator light and audible sequences
that you may encounter during Power-On Self-Test (POST) or computer restart, the probable source of the
problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and non-
error text messages. If a POST error occurs, the screen will display the error message. To manually switch to
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is
POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish the
schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.
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POST numeric codes and text messages
This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM checksum. 1. Verify the correct ROM.

2. Flash the ROM if needed.

3. Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 169.)

4. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 169.)

2. Replace the system board.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard Devices.

Reset the date and time under Control Panel. If
the problem persists, replace the RTC battery.
See the Removal and Replacement section for
instructions on installing a new battery, or
contact an authorized dealer or reseller for RTC
battery replacement.

163-Time & Date Not Set Invalid time or date in configuration memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control Panel
(Computer Setup can also be used). If the
problem persists, replace the RTC battery. See
the Removal and Replacement section for
instructions on installing a new battery, or
contact an authorized dealer or reseller for RTC
battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly installed. Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory changes.

164-MemorySize Error Memory configuration incorrect. 1. Run Computer Setup or Windows utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.
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Control panel message Description Recommended action

201-Memory Error RAM failure. 1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty
memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in Memory
Socket(s) X, X, ...

A memory module in memory socket identified
in the error message is missing critical SPD
information, or is incompatible with the
chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace DIMM with a module conforming
to the SPD standard.

214-DIMM Configuration Warning Populated DIMM Configuration is not optimized. Rearrange the DIMMs so that each channel has
the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support ECC
memory error correction.

1. If additional memory was recently added,
remove it to see if the problem remains.

2. Check product documentation for
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure Graphics display controller. 1. Reseat the graphics card (if applicable).

2. Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 169.)

3. Verify monitor is attached and turned on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest BIOS
image.
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Control panel message Description Recommended action

511-CPU, CPUA, or CPUB Fan not Detected CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front Chassis Fan
not Detected

Chassis, rear chassis, or front chassis fan is not
connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected Front chassis fan is not connected or may have
malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

514-CPU or Chassis Fan not Detected CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.

2. Reseat fan cable.

3. Replace CPU or chassis fan.

515-Power Supply fan not detected Power supply fan is not connected or may have
malfunctioned.

1. Reseat power supply fan.

2. Reseat fan cable.

3. Replace power supply fan.

660-Display cache is detected unreliable Integrated graphics controller display cache is
not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed Since
Last System Startup

Computer cover was removed since last system
startup.

No action required.

917-Front Audio Not Connected Front audio connector has been detached or
unseated from motherboard.

Reconnect or replace front audio cable.

918-Front USB Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

1151-Serial Port A Address Conflict Detected Both external and internal serial ports are
assigned to COM1.

1. Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 169.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict Detected Both external and internal serial ports are
assigned to COM2.

1. Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 169.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are
assigned to same IRQ.

1. Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 169.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
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Control panel message Description Recommended action

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup and
run the Drive Protection System test
under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

1796-SATA Cabling Error One or more SATA devices are improperly
attached. For optimal performance, the SATA 0
and SATA 1 connectors must be used before
SATA 2.

Ensure SATA connectors are used in ascending
order. For one device, use SATA 0. For two
devices, use SATA 0 and SATA 1. For three
devices, use SATA 0, SATA 1, and SATA 2.

1797-SATA Drivelock is not supported in RAID
mode.

Drivelock is enabled on one or more SATA hard
drives, and they cannot be accessed while the
system is configured for RAID mode.

Either remove the Drivelocked SATA device or
disable the Drivelock feature. To disable the
Drivelock feature, enter Computer Setup,
change Storage > Storage Options > SATA
Emulation to IDE, and select File > Save
Changes and Exit. Reenter Computer Setup and
select Security > Drivelock Security. For each
listed Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change Storage >
Storage Options > SATA Emulation back to
RAID and select File > Save Changes and Exit.

1801-Microcode Patch Error Processor is not supported by ROM BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was recently
changed, unplug the computer, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.

2201-MEBx Module did not checksum correctly Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.
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Control panel message Description Recommended action

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.

2203-Setup error during MEBx execution MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.

2204-Inventory error during MEBx execution BIOS information passed to the MEBx resulted
in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2205-Interface error during MEBx execution MEBx operation experienced a hardware error
during communication with ME.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMM1 is not installed. Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning will
not allow BIOS to update provision file
properly.

1. Try a different USB key device for
provisioning.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2217-ME Firmware Version request failure ME firmware is not properly responding to BIOS
query for version information.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

162 Chapter 10   POST error messages ENWW



Control panel message Description Recommended action

2218-ME Firmware Version should be updated ME firmware must be updated to match current
functionality contained in the system BIOS.

1. Update to the latest ME firmware version.

2. If the error persists and system BIOS has
been recently updated, restore previous
system BIOS version.

3. If the error still persists, replace the
system board.

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key has
been corrupted or is not a valid version for the
current ME firmware.

1. Recreate the provisioning file using third
party management console software.

2. If the error persists and system BIOS has
been recently updated, restore previous
system BIOS version. Otherwise, update
the ME firmware version.

3. If the error still persists, replace the
system board.

2220-USB Key Provisioning file has mismatch
version

Provisioning file contained on the USB key is
not a valid version for the current ME firmware.

1. Reboot the computer.

2. If the error persists and system BIOS has
been recently updated, restore previous
system BIOS version. Otherwise, update
the ME firmware version.

3. If the error still persists, replace the
system board.

2230-General error during MEBx execution Error occurred during MEBx execution which
fails into the “General” grouping. Status
information displayed along with the error
provides further clarity into the failure. MEBx
handles transference of information between
the system BIOS and ME firmware.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2231-ME error during MEBx execution Error occurred during MEBx execution which
fails into “ME” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2232-AMT error during MEBx execution Error occurred during MEBx execution which
fails into “AMT” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2233-HECI error during MEBx execution Error occurred during MEBx execution which
fails into “MEI or HECI” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.
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Control panel message Description Recommended action

2239-ME image lock failure Special system configurations with reduced ME
firmware image require BIOS control of ME
firmware upgrading. A failure has occurred
after the ME firmware update process in which
the BIOS could not relock the ME firmware
region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2240-ME image unlock failure Special system configurations with reduced ME
firmware image require BIOS control of ME
firmware upgrading. A failure has occurred
prior to the ME firmware update process in
which the BIOS could not unlock the ME
firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No Keyboard
Attached

Keyboard failure while Network Server Mode
enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.
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Interpreting POST diagnostic front panel LEDs
This section covers the front panel LED codes as well as the audible codes that may occur before or during
POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be performed.

Not all diagnostic lights and audible codes are available on all models.

Activity Beeps Possible Cause Recommended Action

White Power LED On. None Computer on. None

White Power LED flashes every
two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the mouse to
wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

2 Processor thermal
protection activated:

A fan may be blocked or not
turning.

OR

The heat sink/fan assembly
is not properly attached to
the processor.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not
spinning, make sure the fan's cable is plugged
onto the system board header.

3. If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4. Contact an authorized reseller or service
provider.

Red Power LED flashes three
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

3 Processor not installed (not
an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.

Red Power LED flashes four
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

4 Power failure (power supply
is overloaded).

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices. Power on the
system. If the system enters the POST, then
power off and replace one device at a time and
repeat this procedure until failure occurs.
Replace the device that is causing the failure.
Continue adding devices one at a time to
ensure all devices are functioning properly.

3. Replace the power supply.

4. Replace the system board.
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Activity Beeps Possible Cause Recommended Action

Red Power LED flashes five
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or the
system board, you must unplug the computer power
cord before attempting to reseat, install, or remove
a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Red Power LED flashes six times,
once every second, followed by
a two second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the
system board.

Red Power LED flashes seven
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

7 System board failure (ROM
detected failure prior to
video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

8 Invalid ROM based on bad
checksum.

1. Reflash the system ROM with the latest BIOS
image.

2. Replace the system board.

Red Power LED flashes nine
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

9 System powers on but is
unable to boot.

1. Unplug the AC power cord from the computer,
wait 30 seconds, then plug the power cord
back in to the computer.

2. Replace the system board.

3. Replace the processor.

Red Power LED flashes eleven
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

11 The current processor does
not support a feature
previously enabled on this
system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10)
utility.

3. Reinstall the original processor.
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Activity Beeps Possible Cause Recommended Action

Red Power LED flashes eleven
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

12 MXM thermal shutdown. 1. Clean the MXM graphics card heat sink.

2. Replace the MXM graphics card heat sink.

3. Replace the MXM graphic card.

System does not power on and
LEDs are not flashing.

None System unable to power on. Press and hold the power button for less than 4
seconds. If the hard drive LED turns white, the power
button is working correctly. Try the following:

▲ Replace the system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on white
then:

1. Check that the unit is plugged into a working
AC outlet.

2. Open rear cover and check that the power
button cable is properly connected to the
system board.

3. Check to see if the 5V_aux light on the system
board is turned on. If it is turned on, then
replace the power button board and cable. If
the problem persists, replace the system
board.

4. Replace the AC adapter.
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11 Password security and resetting CMOS

This computer supports security password features, which can be established through the Computer Setup
Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password, any user
can access all the information on the computer except Computer Setup. When you establish only a power-on
password, the power-on password is required to access Computer Setup and any other information on the
computer. When you establish both passwords, only the setup password will give you access to Computer
Setup.

When both passwords are set, the setup password can also be used in place of the power-on password as an
override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back up
the computer CMOS settings before resetting them in case they are needed later. Back up is easily done
through Computer Setup. See Computer Setup (F10) Utility on page 93 for information.

CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup
password or the power-on password, the computer is inaccessible and can no longer be used.

Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.

If you lose or forget the password, the system board must be replaced. This scenario is not covered under
warranty.

To prevent the computer from becoming permanently unusable, record your configured setup password or
power-on password in a safe place away from your computer. Without these passwords, the computer
cannot be unlocked.
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Resetting the password jumper
CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup
password or the power-on password, the computer is inaccessible and can no longer be used.

Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.

If you lose or forget the password, the system board must be replaced. This scenario is not covered under
warranty.

To prevent the computer from becoming permanently unusable, record your configured setup password or
power-on password in a safe place away from your computer. Without these passwords, the computer
cannot be unlocked.

To disable the power-on or setup password features, or to clear the power-on or setup passwords, complete
the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any residual
power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the access panel.

4. Locate the header and jumper.

NOTE: The password jumper is green so that it can be easily identified. For assistance locating the
password jumper and other system board components, see the system board components image at
System board callouts on page 82.

5. Remove the jumper from pins 1 and 2.

6. Place the jumper on either pin 1 or 2, but not both, so that it does not get lost.

7. Replace the access panel and reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

9. Shut down the computer, unplug the power, and disconnect the external equipment.

10. Remove the access panel.

11. Place the jumper on pins 1 and 2.
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12. Replace the access panel.

13. Reconnect the external equipment and plug in the computer.

Establishing a setup or power-on password
To establish the power-on or setup password features, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer turns on, press the Esc key while “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

3. Press the F10 key to enter Computer Setup.

4. To establish Setup password, select Security > Setup Password and follow the instructions.

– or –

To establish a Power-On password, select Security > Power-On Password and follow the instructions
on the screen

5. Before exiting, click File > Save Changes and Exit.

Resetting the setup and power-on password
To disable the power-on or setup password features, or to clear the power-on or setup passwords, complete
the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any residual
power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Regulatory, Safety and Environmental Notices guide for more
information.

3. Remove the access panel.

4. Locate the header and jumper labeled PSWD.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating the
password jumper and other system board components, see the Illustrated Parts & Service Map (IPSM).
The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper.
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6. Replace the jumper.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

10. Establish the new passwords in Computer Setup. See Computer Setup (F10) Utility on page 93 for
information.

Changing a setup or power-on password
To change the power-on or setup password, complete the following steps:

1. Turn on or restart the computer.

To change the setup password, go to step 2.

To change the power-on password, go to step 3.

2. To change the setup password, as soon as the computer turns on:

- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.

- Press the F10 key to enter Computer Setup.

3. When the key icon appears, type your current password, a slash (/) or alternate delimiter character,
your new password, another slash (/) or alternate delimiter character, and your new password again as
shown:

current password/new password/new password

NOTE: Type the new password carefully since the characters do not appear on the screen.

4. Press Enter.

The new password will take effect the next time the computer is restarted.

Clearing and resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management Engine BIOS
Extension (MEBx), including the password. The password will default to “admin” and will need to be reset.
The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during POST.
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1. Turn off the computer and any external devices, and disconnect the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the computer cover or access panel.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back
up the computer CMOS settings before resetting them in case they are needed later. Back up is easily
done through Computer Setup. See Computer Setup (F10) Utility on page 93 for information on backing
up the CMOS settings.

4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS button will
not clear CMOS if the power cord is connected.

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM).

5. Replace the computer cover or access panel.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.
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NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along
with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 93.
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A Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature on
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power
supplies on those computers that do not have external power switches are equipped with internal switches
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in the
country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it or
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits
from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in
any manner, replace it immediately.

Japanese power cord requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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B Statement of Volatility

HP confirms that Intel-based business desktop HP EliteOne 705 G1 23-inch Non-Touch All-in-One systems
contain DDR3 volatile memory (memory amount depends on the customer configuration). In addition, the
motherboard in the condition originally shipped without subsequent modification or the addition or
installation of any applications, features, or functionality, contains the following nonvolatile memory: Real
Time Clock battery backed-up configuration memory (256 Bytes), DIMM Serial Presence Detect (SPD)
configuration data (256 Bytes per module, 128 Bytes programmable), Serial Peripheral Interface (SPI) ROM
for System BIOS (16M Bytes) and Super I/O’s: masked keyboard ROM (overall 2K Bytes).

The following procedure shows the steps that should be taken to restore the Non-Volatile memory found in
the Intel-based HP EliteOne 705 G1 23-inch Non-Touch All-in-One systems.

1. Download the latest BIOS (system ROM) from the HP website.

2. Follow the instructions to flash the BIOS that are found on the website.

Flashing the BIOS will reset it back to factory settings.

3. Turn on the system, and while system is powering on, and after the HP splash screen, press the F10 key
to enter BIOS setup screen.

4. Select Security > System Security from the main menu. If the Embedded Security Device Support
option is set to “Disable”, skip to step 7.

5. To erase all security keys from the TPM:

Under Embedded Security Device in the System Security menu, configure Reset to Factory Settings to
Reset.

NOTE: Although the TPM security keys will be cleared, data in the non-volatile memory indices may
not be. Data stored in these indices should not contain security sensitive information. If an application
locks down and secures the non-volatile indices, these indices cannot be cleared.

6. Press F10 to accept changes.

7. To clear the secure boot key database:

a. Enter the F10 setup utility.

b. Go to the Security menu.

c. Select Secure Boot Configuration.

d. In the Key Management section, select clear Secure boot keys.

e. Use space key to select clear.
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f. Press the F10 key to accept changes.

g. From the main menu select File > Save Changes and Exit.

8. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System Ids.

9. Select File > Save Changes and Exit.

10. To clear the Setup or Power-On passwords if set, and clear any other settings, power down the
computer and remove the AC power cord and the computer hood.

11. Locate the green two pin password jumper on header E49 (labeled PSWD) and remove it.

12. Remove the AC power, wait 10 seconds until the unit AC power has drained out, then press the clear
CMOS button. This is typically a yellow push button (labeled CMOS).

13. Replace the hood and AC power cord and turn the computer on. The passwords are now cleared and all
other user-configurable, non-volatile memory settings are reset to their factory default values.

14. Enter the F10 setup utility.

15. Select File > Default Setup > Restore Factory Settings as Default. This will set the default settings
back to the factory defaults.

16. Select File > Apply Defaults and Exit.

17. Shut down the computer, remove the AC power cord and place the (blue/green) jumper back on header
E49. Replace the computer hood and power cord.

If Computrace is enabled on the computer, see the service provider for instruction to disable the feature.
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C Specifications

Dimensions (with stand)

Height

Width

Depth

16.8 in

20.5 in

7.7 in

42.6 cm

52.2 cm

19.6 cm

Approximate Weight (with stand)
19.5 lb – 22.2 lbs 8.83 kg – 10.08 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (non-condensing)

Operating

Non-operating

10-90% at ambient

5-95% at ambient

10-90% at ambient

5-95% at ambient

Maximum Altitude (unpressurized)

Operating

Non-operating

0 - 10,000 ft

0 - 30,000 ft

0 - 3,048 m

9,144 m

Power Supply

Rated Voltage Range

Rated Line Frequency

100-240 V

50-60 Hz

Max Operating Power 180 W
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